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Введение
Однажды январским днем я принесла в класс созданную мной газету. Выпуск я посвятила нашему классу, преподавателям и друзьям. Ребята и учителя хорошо отозвались о выпуске, и мне захотелось продолжить начатое дело. Второй выпуск, февральский, я посвятила Дню рождения своего классного руководителя Мельниковой Натальи Борисовны. Я включила фотографии, поздравительное стихотворение собственного сочинения и рассказ – признание нашему учителю. А впереди – третий выпуск. Я сочинила стихотворение мамам в честь Международного женского дня, оформлю фотографии  с нашего классного праздника, подберу еще материал, а, может быть, воспользуюсь помощью «журналистов», которые откликнутся помогать оформлять газету.

Мой учитель предложил участвовать с темой создания газеты в Малой академии исследователей. Это серьёзно! И я задумалась, а все ли я делаю так при создании газеты? Мне стало интересна история газет, особенности их профессионального издания и возможности самостоятельного выпуска газет. Так родилась тема работы «Как выпустить свою газету?». В работе мне очень помогла Кашкарова Т.Н., наш школьный библиотекарь. 

Я поняла, что этот материал для меня очень важный. Возможно, он будет интересен и вам.

Итак, тема работы – «Как  создать свою газету?». 
Целью представленной работы является рассмотрение модели создания газеты.
Объект исследования: газеты, их содержание, особенности издания.

Задачи: 

1) дать определение газеты;

2) изучить историю создания газет;

3) рассмотреть особенности конструирования, издания;

4) представить вниманию приемлемую модель создания газеты.

Методы исследования: научный, анализ литературных источников, практический  -  демонстрация выпусков собственной газеты.

Гипотеза: газету создавать реально и выпускать самостоятельно возможно.

Результат исследований: 

· мы узнали особенности газет;

· познакомились с этапами  создания и историей возникновения газет;

· доказали возможность самостоятельного выпуска газет.

Выводы: Создавать газету интересно, но надо прилагать много усилий и старания. Газета имеет практическую пользу.

Практическое применение данной работы возможно на классных часах, в кружковой работе.
ЧТО ТАКОЕ ГАЗЕТА

А вы никогда не мечтали выпустить свою газету? Думаете, что для этого нужно много денег и хорошие связи? Нет, на самом деле все гораздо проще. Читайте эту работу, и вы узнаете, как создать газету и что для этого нужно.

Но для начала обратимся к определению «газеты» и узнаем много интересного из её истории.

Газета — печатное периодическое издание, выходящее под постоянным названием и не реже одного раза в месяц. Прообразом газеты считают древние рукописные сводки новостей. Ещё Юлий Цезарь начал публиковать «Деяния сената», а затем «Ежедневные общественные деяния народа». Римские газеты представляли собой глиняные дощечки, на которых записывали хронику событий. Примерно с 911 года в Китае начал выходить «Цзинь бао» («Столичный вестник»). 

Название «газета» произошло от наименования мелкой итальянской монеты. В XVI веке за прочтение ежедневного публичного листка с информацией (сообщениями о придворной жизни, торговых новостях, сообщениями из других городов) платили одну «гасету», то есть самую маленькую монету. Название же монеты дала сорока (итал.), изображённая на ней. 

Согласно советскому ГОСТу, газета  — «листовое издание в виде одного или нескольких листов печатного материала установленного формата, издательски приспособленное к специфике данного периодического издания». 

История газет
Предшественниками газет традиционно считаются новостные сообщения, распространявшиеся в Древнем Риме о событиях, произошедших в городе. Переписывавшиеся от руки свитки под названием  «Ежедневные дела римского народа» вывешивались на площадях и доставлялись политикам или просто знатным горожанам. Римские газеты представляли собой деревянные дощечки, на которых записывали хронику событий. Новостные сводки, как правило, имели неофициальный характер, пока Юлий Цезарь не распорядился в обязательном порядке распространять отчёты о заседаниях сената, донесения полководцев и послания правителей соседних государств.

Первой в мире печатной газетой стал «Столичный вестник», который начал выходить в Китае в VIII веке. В ней помещали указы императора и сообщения о важнейших событиях. Газеты печатали с досок, на которых вырезали иероглифы, покрывали тушью и делали оттиски. Эта технология была крайне неудобной, так как доска от частого покрывания краской быстро приходила в негодность.

На протяжении последующих столетий в газетах мало что изменилось: вплоть до изобретения в Германии в 1450-х годах Иоганном Гутенбергом печатного пресса, позволявшего размножать текст и изображения, не прибегая к услугам переписчиков, газеты (представлявшие собой всё те же переписанные от руки свитки с главными новостями) оставались весьма дорогим атрибутом жизни высокопоставленных чиновников или богатых торговцев. 

Свой современный облик газеты начали приобретать в XVI веке. Тогда и вошло в обиход само название «газета» — по наименованию мелкой итальянской монеты, которую обычно платили за рукописный листок новостей в Венеции. Считается, что именно в этом городе были образованы первые бюро по сбору информации — прообразы информационных агентств — и возникла профессия «писателей новостей».

К числу первых газет, сильно напоминающих современные нам издания, принято относить издававшуюся с 30 мая 1631 года во Франции газету «La Gasette». Тираж газеты насчитывал около 1200 экземпляров, а её издателем стал получивший в 1630 году патент на распространение новостей по территории Франции дворянин Теофраст Ренодо. Политическое значение «La Gasette» было настолько велико, что некоторые сообщения в неё писали лично король Франции Людовик XIII, а также кардинал Ришелье. Значение «La Gasette» для развития этого типа СМИ было особенно велико ещё и потому, что в «La Gasette» стала размещаться платная реклама. В 1657 году одна из английских газет опубликовала первое рекламное предложение, вскоре король Карл II разместил частное объявление о пропаже любимой собаки, а полвека спустя Даниэль Дефо положил начало политической журналистике, основав еженедельник «Обозрение государственных дел».

Годом рождения европейской газетной периодики считается 1605 год. Первое издание появилось в Страсбурге. Его редактором-издателем стал типограф Иоганн Каролус, ранее занимавшийся составлением рукописных газет. В январе 1609 года в городе Вольфенбюттель опубликована первая сохранившаяся до наших дней газета. Она называлась «Aviso». В ней были помещены новости из Кёльна, Антверпена, Рима, Венеции, Вены и Праги. Проникшее в немецкую печать  итальянское слово «Avviso» свидетельствует о генетической связи между первыми немецкими еженедельными газетами и их венецианскими прообразами. Формат немецких изданий и форма подачи новостей также напоминает венецианские Avvisi.
Газеты в Германии в XVII веке

Первые печатные газеты не имели четко обозначенного названия. Место издания и фамилия редактора-издателя обычно не указывались. Расположение новостного материала зависело не от степени важности самого описываемого события, а от дня поступления данной информации. Сами новости практически не комментировались и подавались без всяких рубрик, политические события перемежались с далеко не всегда достоверными сенсациями.

История газет в России

Прежде, чем в России появились печатные газеты, в Посольском приказе долгое время для царя и бояр составляли периодические рукописные обзоры немецкой и голландской прессы. Их называли курантами. 15 декабря 1702 г. Пётр I издал указ, по которому куранты следовало передавать в Монастырский приказ (в его ведении находилась типография) и печатать для продажи "в мир". Перед изданием куранты редактировались. В нескольких случаях Пётр сам проводил корректуру. От первых газет, вышедших еще в конце 1702 г. сохранились лишь корректуры и рукописные копии. Первый сохранившийся выпуск этой газеты издан в Москве 2 (13) января 1703 года (годовщина этой даты отмечается как День российской печати). Газета представляла собой восьмушку листа, почти без полей, церковного шрифта (в отдельных случаях формат мог меняться, а церковный шрифт сменился на гражданский). Постоянного названия газета не имела. Однако в большинстве вариантов заголовка встречается слово "Ведомости". В литературе по истории прессы его принято рассматривать как наименование издания. Газета не имела постоянного тиража (от 1-2 тыс. до 30 экз.). Периодичность ее выхода зависела от работы почты, доставлявшей иностранную прессу, степени загруженности переводчиков Посольского приказа и свободных типографских мощностей. Кроме Москвы, отдельные номера Ведомостей издавались и в Петербурге. Постепенно новая столица стала основным местом издания газеты, а обзоры иностранной прессы стали составляться в Коллегии иностранных дел.

Первые американские газеты
Английские колонисты в Америке, из-за небольшой плотности населения и жесткого правления узнали о существовании газет сравнительно поздно. 25 сентября 1690 в Бостоне вышел первый номер «Паблик оккеренсиз». Первую заметку этой первой в Америке газеты следует признать удачной: «Обращенные в христианство индейцы в некоторых частях Плимута недавно назначили день благодарения Господа за Его Милости». Однако, если газета намеревалась выжить, прочие материалы, надо признать, были выбраны не столь удачно. «Паблик оккеренсиз» содержала нападки на индейцев, воевавших на стороне англичан против французов, и пересказ скабрезной сплетни о французском монархе. Эта журналистика отражала вкусы издателя Бенджамина Харриса, который выпускал в Англии газетенку сплетен и сенсаций, пока его не отправили за решетку, а после того, как он опубликовал провокационную заметку о якобы имевшем место католическом заговоре против Англии, вынудили эмигрировать в Америку. Власти Массачусетса тотчас выразили свое «высокое негодование и возмущение» по поводу «Паблик оккеренсиз», так что первый выпуск первой американской газеты оказался последним. Очередная газета появилась в колониях лишь спустя 14 лет.

XIX
век
Настоящий мировой бум газет пришёлся на XIX век, когда в газеты сместился центр политической и общественной жизни многих стран Европы. В XX веке газеты продолжали успешно развиваться, постепенно видоизменяясь из-за появления таких новых электронных СМИ, как радио (в 1920-е годы) и телевидения (в 1950-е годы). Не будучи способными конкурировать с радио и телевидением в оперативности передачи информации и эмоциональности представления сюжетов, газеты сделали основную ставку на комментарии, подробный анализ событий, а также на развитие таких приложений, как освещение местных новостей и всевозможные мелкие объявления.

XX
век
В конце XX века, с появлением Интернета, куда ушла значительная часть рекламных объявлений, газеты стали переживать определённый кризис. Ответом на этот кризис для многих газет стал переход в таблоидный формат, позволяющий экономить бумагу, а также привлекать более короткими и эмоциональными статьями большое количество молодых динамичных читателей, которые оставались неохваченными прежними консервативными газетами. Тем не менее, переход в формат таблоида не является для современных газет панацеей и не всегда приносит ожидаемый экономический эффект. В настоящее время большинство газет мира находится в поиске новых форм подачи материалов и привлечения читателей и рекламодателей.

В XXI веке продолжает выходить единственная рукописная газета — Мусальман. Четыре каллиграфа ежедневно записывают её текст на языке урду, а затем образец размножается с помощью печатного пресса.

ВИДЫ И ТИПЫ ГАЗЕТ

Газеты делятся:

· по принципу территориального распространения и охвату аудитории — общенациональные, региональные (республиканские, областные, краевые), местные (городские, районные), внутрикорпоративные (обращенные к сотрудникам определённой организации), многотиражные, профессиональные;

· по тематике — деловые, общеполитические, отраслевые, рекламно-информационные, развлекательные, смешанные;

· по возрастному принципу — детские, молодёжные газеты, газеты для пенсионеров и тд.;

· по периодичности — ежедневные (утренние или вечерние), еженедельные, ежемесячные;

· по формату — А4, Берлинер, АЗ, А2;

· по стилю оформления — цветные,  чёрно-белые и чёрно-белые с цветными вставками;

· по качеству: солидные, популярные, «желтые»;

по стоимости — платные и бесплатные.

ОСОБЕННОСТИ  ГАЗЕТ

· Мобильность — газету можно читать как дома, так и в любом другом месте;

· Общедоступность — газета предназначена для неопределённого круга лиц, читателем её может стать любой человек;

· Периодичность — газета относится к периодическим изданиям, выходящим в свет по установленному издателем графику. По этому признаку газеты делятся на ежедневные, еженедельные, ежемесячные (редко). Существуют газеты выходящие два или три раза в неделю, два раза в месяц и т. п. Существуют также утренние и вечерние газеты;

· Официальность — многие решения (распоряжения, законы и т. п.) властных органов всех уровней вступают в силу только после их официального опубликования в газете или другом печатном органе.

ГАЗЕТНЫЕ ЖАНРЫ

Основные функции средств массовой коммуникации — информация, образование, создание общественного мнения и воспитание — находят своё отражение в конкретных жанровых формах.

Использование тех или иных жанров определяется в первую очередь общественно-историческими условиями жизни. Например, в довоенной советской журналистике был очень распространён жанр очерка. По свидетельству известного в то время журналиста Семена Нариньяни в «Комсомольской правде» 1930-х годов очерк был жанром номер один. «Иногда в одном номере печаталось по два-три очерка сразу. На второй странице очерк производственный, на третьей — морально-этический, на последней — спортивный или научный.» То есть в газетах того времени преобладали материалы, несущие образовательную, воспитательную функции. Постигая грамоту, народные массы молодой советской республики тянулись к знаниям, и газеты старались выполнять стоящие перед ними задачи — обучать и воспитывать людей на ярких примерах новой жизни.

Сегодня мы наблюдаем иную картину: крупные жанры на полосах ежедневных газет появляются не очень часто, они перекочевали в еженедельники, журналы. На первое же место вышли информационные жанры. Ускоренный темп жизни, информационный бум диктуют изданиям и соответствующие формы подачи материалов. Многие газеты, учитывая читательские интересы, ориентируют журналистов на небольшие по объёму — 100—120 строк — материалы не только информационных, но и аналитических жанров с многочисленными фактами, лаконичной аргументацией, без лишних слов.

Наряду с традиционными жанровыми формами сегодня на страницах газет и журналов появляются новые, например, научно-популярные эссе, социально-политические диалоги, социальные портреты современников, социально-экономические очерки, проблемные социальные критические репортажи, аналитические интервью и т. д.

В международной журналистике многие жанры требуют специального исполнения. Газетные материалы должны обладать определенной направленностью — тщательным учетом всех специфических черт, свойственных аудитории той или иной страны или группы стран, для которых предназначается публикация, а также черт, свойственных местным газетам.

Информационные жанры

Информационные жанры — заметка, репортаж, отчёт, интервью — отличаются оперативностью, наличием в материалах событийного повода, рассмотрением отдельного факта, явления.

Этим жанрам отводится наибольшая часть газетной площади. Именно эти жанры несут аудитории все последние новости. В некоторых газетах их обозначают одним общим термином «новости», часто вкладывая в это понятие не просто сообщение о чём-то новом, а о сенсационном факте.

Сенсация — самый ходовой товар в массовой прессе. Издателю он повышает тиражи газет, приносит прибыли. Усилия репортёров этих изданий направлены на то, чтобы каждый номер обеспечить необычной, захватывающей новостью. И на страницы газет сплошным потоком идут материалы о катастрофах и убийствах, пожарах и наводнениях. А если вдруг ничего не случилось, сенсации приходится выдумывать, используя слухи и т. д.

Новости в такой печати — главный жанр. Они занимают больше половины площади газет (не считая рекламы). Светская, скандальная хроника, политические, экономические, спортивные сообщения заполняют многочисленные полосы. Обилие новостей приводит к тому, что многие читатели ограничиваются просмотром одних заголовков или в лучшем случае чтением первых абзацев, набранных крупным шрифтом. В заголовок или начало материала выносятся наиболее выгодные, часто второстепенные детали. Читатель же, приученный к тому, что изложение информационных материалов строится по принципу «перевернутой пирамиды» (главное сообщается вначале, а затем все менее и менее существенные подробности, чтобы легко было сокращать материал с конца при макетировании и вёрстке), воспринимает их как самое важное в сообщении.

Жанр материала журналист выбирает в зависимости от его содержания, от того насколько важны, злободневны и интересны найденные, отобранные факты.

Накопив достаточные сведения об истории газет, их жанрах и особенностях, перейдем к практической части, в которой рассмотрим процесс создания собственной газеты.

ПРАКТИЧЕСКАЯ  ЧАСТЬ  «СОЗДАНИЕ ГАЗЕТЫ»

СПОСОБ 1.

Я представлю вниманию один из вариантов создания газеты, позаимствованный из Интернета.

Итак, для начала определимся с форматом газеты. Например, будем создавать рекламную газету формата А3. Газета будет раздаваться бесплатно. Прибыль с такой газеты идет с рекламы, которая в ней размещена. Причем в маленьком городе, где таких газет еще нет, это дело идет лучше.

Затем по идее необходимо арендовать офис, но если денежных средств очень мало, то можно начать создавать газету дома. 
Чтобы газета была интересна читателям, и они ее сразу не выбрасывали, то хорошо бы кроме рекламы опубликовать в этой газете какие-нибудь советы или рецепты, будь то кулинарные или красоты. Также благодаря этому спрос на газету должен увеличиться, а это в свою очередь увеличит спрос рекламодателей. Также можно добавить в газету кроссворды, головоломки, гороскоп, анекдоты. Все это увеличивает спрос на газету. 

Затем наймите на работу сотрудника, который будет разносить газету по почтовым ящикам. Можно также поставить на улице человека, который будет раздавать газету. Так она будет сразу попадать в руки читателям.

Теперь несколько слов о затратах, работе и прибыли от создания своей газеты. Итак, на закупку оборудования необходимо порядка сорока тысяч рублей. Ризограф может работать сутками без перерывов, печатая большие тиражи. На компьютере можно сэкономить. Главное, чтобы на него вы смогли установить программу Photoshop. Программу можно скачать с Интернета.

График работы по созданию очередного номера газеты вы можете сделать таким. Например, в понедельник и вторник собираете заказы от рекламодателей. Причем в это время вы можете сидеть дома и просто работать на телефоне. В среду работаете над дизайном газеты. На это, когда вы приобретете опыт, будет уходить максимум часа 3. В четверг печатаете газету на ризографе. Займет это у вас максимум 1 час. А пятницу уделяете на распространение газеты. Ну, здесь количество затрачиваемого времени зависит от того, будете ли вы делать это один или привлечете помощников. Но все равно, рабочая неделя получается меньше по времени, чем на обычной работе. 

Заработать на газете можно от 20000 рублей в месяц, причем, если газета не сшивается. Если же газету вы будете сшивать, и в ней будет много листов, то заработаете гораздо больше.

Стоимость размещения объявления, рекламы в первом номере газеты можно сделать бесплатным. Конечно, при этом вы поработаете в убыток. Во втором номере газеты можно сделать стоимость рекламы или объявления рублей 100. И так постепенно можно увеличивать с каждым номером газеты рублей до трехсот. Потом можно и остановиться, иначе более высокой ценой за рекламу растеряете своих клиентов.

Что касается тиража газеты, то для начала можно начать с 1000 экземпляров в месяц. А потом в другом месяце тираж можно увеличить. Также лучше сначала начать выпускать черно-белую газету. И если успех вас не обойдет стороной, то можно перейти и на цветную. 

Итак, основные тонкости в создании своей газеты вы теперь знаете. Следуйте основным этапам, которые описаны в этом материале и успех вас не заставит ждать.

Удачи! 

СПОСОБ 2.

А вот другой способ, позаимствованный тоже из сети Интернет. Мне он больше понравился.

Создание газеты или новостной рассылки - дело стоящее и полезное. С ее помощью можно сообщить своей семье последние новости или рассказать сотрудникам о новых событиях в жизни компании, а то и вовсе показать, скажем, студентам, что такое журналистика! Редактор Microsoft Word дает возможность без особых проблем создать газеты и новостные рассылки.

ШАГ 1

Возьмите несколько газет. Вдохновляйтесь тем, что видите на прилавках газетных киосков. Смотрите и думайте, что удачно, а что - не очень. Смотрите и учитесь тому, как надо располагать заголовки и изображения, чтобы те привлекали читателя. Попробуйте понять, как взаимодействуют все эти базовые элементы газеты. 

· Истории - суть газеты, большая часть текста.

· Изображения - тоже важный момент, ведь они разбивают стены текста и предоставляют контекст для историй. Кроме того, важны подписи, объясняющие значение изображений.

· Заголовки - первое, что увидит читатель. Именно заголовки помогают читателям понять, купит он газету или же нет.

· Боковые полосы - в них содержится дополнительная информация по теме истории.

ШАГ 2. 

          Перед началом работы необходимо продумать шаблон. Именно так. Будет весьма неплохо, если набросок того, как должна выглядеть газета, будет у вас в голове или на черновиках еще до того, как вы откроете текстовый редактор. 

· Нарисуйте разные страницы. Первая страница существенно отличается от всех прочих, а у разных разделов может быть слегка отличающийся стиль.

· Рисуйте линии, чтобы увидеть, как колонки влияют на вид страницы. Слишком много колонок - текст кажется слишком скученным. Слишком мало колонок - все кажется каким-то блочным, угловатым…

· Располагайте текстовые блоки по-разному. Размещайте текст вокруг изображений, помещайте изображение под или над текстом, в общем - сами смотрите.

· Экспериментируйте с положением заголовков. Заголовки, как вы помните, должны привлекать внимание читателей, но не отвлекать их.

ШАГ 3

Определитесь с размером страницы. В Америке, к примеру, стандартный формат - 37х55 сантиметров. Да, в текстовом редакторе можно и не такое сделать - но вот распечатаете ли вы такие листы на домашнем принтере? 

· Обратитесь к формату новостной рассылки. А что, всего две колонки и стандартный лист А4.

· Сгиб газетных листов таки влияет на дизайн. Обычная газета сгибается пополам горизонтально, чтобы важный контент оставался на верхней половине первой страницы.

ШАГ 4.

Соберите все ваши статьи в подходящих форматах. Если вы занимаетесь дизайном, то у вас наверняка будут статьи от множества авторов. Убедитесь, что вы можете работать с форматом этих статей, чтобы потом проблем не было.

СПОСОБ 3. 

ШАГ 1.

Создайте новый документ в текстовом редакторе. Открыв Word, вы можете либо просто создать новый документ, либо создать его из шаблона. 

· Шаблоны: меню Template, раздел Newsletter. Там вы сможете выбрать из множества шаблонов, созданных в Microsoft. В этих шаблонах зачастую имеются инструкции о том, как менять текст и изображения. Шаблоны - это вариант для тех, кто спешит и хочет как можно быстрее сделать газету.

· Те же, кто хотят сделать все самостоятельно, могут выбрать просто создание нового документа.

ШАГ 2. 

Измените размер страницы. Если вы выбрали формат новостной рассылки, то можно оставить размеры по умолчанию. Если же вы хотите полномасштабную газету, то придется кое-что изменить: 

· Откройте вкладку Page Layout > Page Setup. там кликните на стрелочку внизу справа.

· В появившемся окне откройте вкладку Paper, из выпадающего меню выберите Custom Size. Ширину задайте равной 15, высоту - 22.

· Проигнорируйте предупреждение программы о том, что документ вылез за поля печати. Если вы не будете печатать дома - это не проблема.

· Без широкоформатного монитора просмотр страницы теперь будет сложным делом.

ШАГ 3

Создайте заголовок. Дважды кликните на раздел заголовка документа, который расположен выше верхней границы. Откройте вкладку Header & Footer Design. Там можно вставить даты, номера страниц и изменить расположение заголовков. 

· Как правило, на первой странице газеты помещен другой заголовок. Название и даты здесь вполне уместны. Чтобы задать для первой страницы отличный заголовок, перейдите в меню Design > Options > Different First Page.

· Изменить шрифт и стиль заголовка можно так же, как и шрифт и стиль обычного текста.

· Можно нарисовать заголовок в графическом редакторе и просто вставить его в Word картинкой.

СПОСОБ 4. 

Колонки. Word может автоматически создать колонки, которыми будет форматироваться добавляемый вами контент. Впрочем, тут у вас есть несколько вариантов. Чтобы получить доступ к созданию колонок, откройте вкладку Page Layout > Page Setup > Columns. 

· Задайте количество колонок, которое желаете видеть.

· По клику на More Columns вы получите доступ к созданию настраиваемых колонок. Разместите курсор там, где вы хотите внести в колонку изменение, перейдите в меню More Columns > This point forward и кликните Apply to. Все, что выше курсора, не изменится, все, что ниже - изменится.

· Полезно будет учитывать то, как будет выглядеть статья при той или иной длине колонок. Поверьте, работа над параметрами колонок - это сложный момент.

          Картинки. Через вкладку Insert откройте папку с картинками, выберите нужные и вставьте их. Текстовый редактор вставит изображение туда, где находится курсор. Затем откроется вкладка Format. 

· Вы можете перемещать изображение и менять его размеры с помощью мышки.

· Вы можете изменить способ отекания текстом изображения через меню Arrange > Text Wrapping.

· Чтобы свободно перемещать изображение по странице, кликните на кнопку Position в меню Arrange. Выберите любую опцию в разделе With Text Wrapping. Так вы разблокируете изображение и сможете перемещать его куда угодно.

ЗАКЛЮЧЕНИЕ


 В результате аналитической работы и практической работы мы узнали особенности газет; познакомились с этапами  создания и историей возникновения газет; доказали возможность самостоятельного выпуска газет.

Действительно, создавать газету интересно, но надо прилагать много усилий и старания, работать с желанием и хорошим настроением. Газета имеет практическую пользу, приносит читателям и вам, как издателю, большое  удовольствие!

Литература

Ресурсы Интернет

1
2

